
The information contained here works for us and you may use it as a starting point for your own single-molecule AFM experiments. New students in the lab use this manual to get familiar with the technique. For feedback and updates, contact Jorge Alegre-Cebollada (mailto:jalegre@cnic.es).
## INDEX

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHAT IS AN AFM</td>
<td>2</td>
</tr>
<tr>
<td>AFM COMPONENTS</td>
<td>2</td>
</tr>
<tr>
<td>SAMPLE REQUIREMENTS</td>
<td>3</td>
</tr>
<tr>
<td>AFM SETUP</td>
<td>3</td>
</tr>
<tr>
<td>CANTILEVER CALIBRATION</td>
<td>6</td>
</tr>
<tr>
<td>EXPERIMENTAL PROCEDURES</td>
<td>10</td>
</tr>
<tr>
<td>Force Extension Experiments</td>
<td>10</td>
</tr>
<tr>
<td>Force Clamp Experiments</td>
<td>12</td>
</tr>
<tr>
<td>FINISHING THE EXPERIMENTS</td>
<td>14</td>
</tr>
<tr>
<td>DATA ANALYSIS</td>
<td>15</td>
</tr>
<tr>
<td>Trace Selection</td>
<td>15</td>
</tr>
<tr>
<td>Selected Trace Analysis</td>
<td>15</td>
</tr>
<tr>
<td>TROUBLESHOOTING</td>
<td>19</td>
</tr>
<tr>
<td>REFERENCES</td>
<td>19</td>
</tr>
</tbody>
</table>
AFM USER MANUAL

The following document is a detailed description of an Atomic Force Microscopy (AFM) experimental procedure.

WHAT IS AN AFM?

An Atomic force microscopy (AFM) is a high-resolutive type of microscopy, with demonstrated resolution in the order of fractions of a nanometre, more than 1000 times better than the optical diffraction limit (Blanchard, 1996).

In order to fully enable automated operations in force-clamp mode, Luigs & Neumann developed a variation of the AFM, known as LN-AFS, characterized by a feedback loop that allows the maintenance of constant pulling force. This loop moves the piezo surface in the opposite direction to the original one until the measured force matches the set point once again.

AFM COMPONENTS

This manual is intened for the AFM setup provided by Luigs & Neumann, which is shown in the figure below:

![AFM Components Diagram]

Figure 1: A) Overall view of an AFM. B) Scheme of an AFM setup, both extracted from Luigs & Neumann, 2014.
SAMPLE REQUIREMENTS

IMPORTANT: while performing an AFM experiment always wear gloves to protect the sample from substances coming from your hands

Buffer preparation

The fluid chamber must be filled in with degasified and filtered buffer (e.g. HEPES) at room temperature.

To get the buffer filtered:

✓ Use always buffer less than one month old.
✓ Make buffer aliquots using a F2504-10 4 MM filter (ThermoScientific). An aliquot is required for each experiment. The spare aliquots can be kept at 4°C for a week.
✓ Allow the buffer aliquot to reach room temperature before using it.

Protein preparation

The sample must be centrifuged for 10 min at 4°C and maximum speed to remove aggregates and particles.

AFM SETUP

Note: it is advisable to have a personal notebook to keep track of all experiments done by a researcher. This helps navigating the large amount of files that are stored over time

The system needs to be started following a special sequence:

1. Switch on the computer and the vibration isolation system, if not already on.
2. Turn the laser on if the key switch is in the OFF position.
3. Switch on the AFM controller.
4. Launch IGOR Pro.
5. Remove fluid chamber from the AFM.
6. Mount a cantilever in the fluid chamber’s clamp (Figure 2). Use plastic tweezers to avoid scratching the glass (for example, Industrial tweezers K7, Rubis, Switzerland). Make sure the cantilever is aligned with its holder (yellow rectangle in Figure 2) and totally inside the receptacle. A dissecting microscope or magnifying glass can be used for this purpose.

IMPORTANT: the tips of the cantilever are very fragile and can be easily broken by contact with the tweezers etc.

Note: Surrounding the cantilever there is a silicon ring (O-ring) that provides a tight enclosure between the fluid chamber and the surface, slowing down the evaporation of the solution. If wanted, the O-ring can be removed from the holder before placing the cantilever.
7. Place the fluid chamber back on the AFM and secure it with the S9 screw (Figure 2).

IMPORTANT: the fluid chamber platform is magnetic so this step must be carried out carefully in order to smoothly accommodate the fluid chamber back to its position and do not damage the system.

8. Align the laser:

IMPORTANT: depending on the working intensity, the laser can be harmful for the eye. The safety switch and the laser security window never allow a beam catching the eye with an intensity higher than 1 mW. Nevertheless, avoid direct contact with the laser whilst the protective window is open.

✓ Move the AFM’s optic system (camera, objective and illumination) from its rest position to the right until it aligns with the fluid chamber (i.e. until it touches the end stop). This system allows the positioning of the cantilever and the laser spot with a live-video feed. Please note that for the optic system to move, the piezoelectric has to be facing upward!

✓ Focus the cantilever tip using the objective. For this purpose, rotate the focus knob (Figure 2, D2) on top of the objective.

✓ Focus the laser until it has a sharpened circular shape and its centre is white, using the three knobs placed below the fluid chamber to do triangulation movements (Figure 3A). Each one of these knobs is responsible for moving the laser in the x and y axes and in a diagonal direction respectively.

Figure 2: Cell System. H1 Fluid chamber; H2 Cell Slider; H3 Holder; H4 Insert; S3 Fixing knob for X adjustment; S5 Screw for Y adjustment (Luigs & Neumann, 2014).

Figure 3: A) Laser levelling. B) Optic module and piezoelectric actuator: D. Optic System; D1: Objective; D2: Focus knob; D3: Illumination system; E: Piezo system; E1: Button for magnetic device. (Luigs & Neumann, 2014).
Note: there is a light bulb alongside the objective (D3, Figure 3B). This light does not allow the laser visualization, so move it aside before aligning the laser.

- Using the knobs described above, align the laser with the cantilever tip of choice.
- Use the focus knob to make sure that the laser is focused on the plane of the cantilever tip.
- Make sure that the photodetector (PD) covers half of the white mark seen in Figure 4B, F2. If not move it upwards or downwards as needed using the F4 handle.
- Rotate and/or displace the mirror placed behind the fluid chamber to change the angle of laser reflection so that it targets the centre of the “dartboard” covering the PD and its shape is circular, as it does in Figure 4A.
- Maximizing the A+B signal may help to get perfect focusing and reduce interference.
- When you’re done, press “alignment done” to close the image of the cantilevers. Do not use the close (X) button to close window.

![Figure 4. A) Adjustment of sensor and laser spot. B) Sensor of photodetector: F1: Target plate, “dartboard”; F2: White mark; F3: Knob for Y alignment; F4: Mirror handle; F5: Sensor.](image)

9. Load the tempered buffer onto the fluid chamber and check that the laser and the cantilever tip are still aligned. Repeat step 8 if necessary, making sure that the buffer is covering the cantilever completely (i.e. that you have a nice image of the cantilever in buffer).

10. If the coverslip from the previous experiment is still in place, remove it. Clean the surface of the piezo with 70% ethanol using a wet piece of paper. Make sure the surface is dry before proceeding to next step.

11. Coat the piezo with a thin layer of sterile grease and place a compressed air-cleaned (gold, chloroalkane, etc) coverslip on it. Even though the coverslip can be cleaned this way, NEVER use compressed air on the piezo, since it may damage it. Always clean the coverslip BEFORE putting it on the piezo.

**IMPORTANT:** The piezo is very fragile, avoid high forces, vibrations or shocks.

12. After centrifuging the protein sample, apply the desired volume on top of the coverslip and gently spread it to create a thin layer as done before with the grease. Use the pipette tip for this, always trying not to scratch the surface.
Note: the amount of protein sample added to the coverslip depends on the concentration obtained during the purification. It may be a good idea to check different amounts to see what works best.

13. Slowly turn the piezo upside down until it faces the fluid chamber.

VERY IMPORTANT: The piezoelectric is magnetic. It is necessary to press the button placed on its side to stop the magnetic field until it is located on its new position (Figure 3, E1). Otherwise, the piezo may hit the granite base, which may damage it.

CANTILEVER CALIBRATION

Before starting any experiment, the calibration of the cantilever is required. This allows to measure forces with accuracy.

Now it is time to go to IGOR. Open it and select AFM tab → initialize options experiment to show a main calibration panel (Figure 5). This main panel is used to calibrate and control the AFM.

![Main calibration panel](image)

**Figure 5**: Main calibration panel. It has three tabs, used for calibration, force extension and force clamp, respectively.

It is necessary to follow the next steps in order to properly calibrate the cantilever:

1. Increase “Laser Intensity” until it reaches 1 AU.

Assuming that the experiment is correctly set up and that the reflected laser beam hits the PD, an A+B signal of around 5-6 V should be obtained (MLCT cantilevers, Bruker). A+B shows the total voltage measured by the PD.

2. Turn “High voltage” option on. This option controls the power supply for the piezo. It is off when the experiment is initialized and has to be switched on manually before the piezo can be moved. After IGOR is closed it switches off automatically.
3. Use the double downward arrow button in the “Stepper Controls” box (Figure 5) to approximate the piezoelectric surface to the O-ring until they touch.
4. Open the PD by sliding the “dartboard” covering it, as seen in Figure 4B, and then, close the protective hood.
5. Rotate the knob in the PD (F3, Figure 4A) until C-D is 0 V. C-D shows the difference in voltage between the left and the right half of the PD.
6. Press “force Null” button (Figure 5)

Note: Force Null option shifts the vertical position of the PD until the A-B signal is close to 0 V. A-B measures the voltage difference between the top and the bottom half parts of the PD. If the experiment is correctly set up, then this signal is directly proportional to the force experienced by the cantilever.

Note: In practical terms, the calibration requires two steps. The first one measures the thermal fluctuations of the cantilever far from the surface to generate a power spectrum, then, this is Fourier-Transformed to switch from a temporal space to a frequencies space. In this Fourier regime, the main vibrational mode can be distinguished from the others. By integrating the area below the first resonance peak, the mean squared displacement \(<(A-B)^2>\) is measured in units of volts^2.

7. Generate a Power Spectrum by setting the “Measure thermal Spectrum” parameters (Figure 5 and Figure shown below) and by then pressing the “Get Spectrum” button. This should be done at several microns from the sample surface (i.e. before approaching the surface to the cantilever). Use # of averages = 32 and spectrum # points = 2^18.

8. After acquiring a spectrum, place the circular cursor to the right and the square cursor to the left of the left main resonance peak as shown in the Figure 5.

9. Press “Get spectrum” one more time to measure the mean squared displacement calibration parameter \(<(A-B)^2>\). Repeat this a couple of times to make sure that a consistent estimate is employed for calibration.

Note: In the second step of calibration, the cantilever is placed closer to the surface and, a deflection-extension curve is measured by IGOR. When in contact, the piezo and the cantilever travel identical distances. This allows IGOR Pro to calculate the slope (S, in nm/V) of the linear relationship that links (A-B) displacement (change in voltage), measured by the PD, with the real bending distance in nanometres measured from the movement of the piezo. Once the slope and \(<(A-B)^2>\) are calculated by IGOR, this programme is able to determine the Spring constant (Ksc, in pN/nm) of the cantilever in use.

10. To carry out the second part of the calibration, press “Force null” again and then press “Stepper Approach” button to bring the sample surface into close proximity to the cantilever tip (Figure 5).
Note: The movement performed by the Stepper Approach is audible and stops when there is a large change in the PD signal indicating that the sample surface has hit the cantilever. At the end of this procedure the sample surface should be close to the cantilever tip, but still not in touch with it, allowing for a manual final approach.

11. Carry out the final manual approach by pressing the single downward arrow in the “Stepper Controls” box. Each time this button is pressed, the piezo moves approximately 50 nm and, when it hits the cantilever surface, the A-B signal suffers from a high increase in V.

12. When the A-B signal increases a lot, go upwards by clicking the upward single arrow twice or three times, until A-B comes back to nearly its original value.

13. Press “Force Null” button to reset A-B value to almost 0 V.

14. Repeat steps number 11-13 until the big change in A-B signal takes place almost immediately after pressing once (or twice) the single downward arrow.

Note: The piezo is close enough to the surface when A-B dramatically changes after just one movement of the single downward arrow.

Note: When the “Force Null” button is pressed, the movement of the piezo by the single arrow buttons is reduced to 20 nm approx. Performing a Stepper Approach brings this movement back to 50 nm. Now the surface is close to the cantilever tip, at around 100-200 nm.

Next step is to obtain the values for the Contact Slope in nm/V and the Spring Constant in Ksc, in pN/nm. This method depends on the specific cantilever we are using.

**Regular MLCT cantilevers**

1. In the main calibration panel (Figure 5), set Amplitude in the “Measure voltage vs. distance slope” box to 500 nm and Pulling Rate (in the same box) to 400 nm/s and press “Get slope”.

Make sure the initial position of the piezoelectric allows the slope calculation at around -2 V. The initial position of the piezo can be controlled using the z-slider (displaces the piezo) or the single-arrow buttons (displace the stepper motor). Force has to reach a minimum value of around -2.1 V and the representation has to be a straight line, with no coincidence with the X axis (what means that the cantilever is too close to the surface).

![Moving the z pos slider to the right displaces the sample surface closer to the cantilever tip.](image)

Note: Move the sliders slowly since abrupt changes are not good for the piezo

2. In the Command Window set both the Spring Constant and the contact slope to 1.

3. Go to the “Force Extension” panel and perform a Single FX acquisition given the following parameters:

Pulling rate=400 nm/s; Amplitude=500 nm; Activate Sawtooth Detector; Stringency=0.2; MinForce=75 pN, Nyquist Fraction=0.5.
Repeat this step until a trace in which force reaches a value of around -2 V is obtained. Then, save it (Save FX button).

4. Duplicate the just saved FX trace by typing “duplicate” in the Command Window. Then, plot Force vs. Extension of the duplicated trace.

5. Go to “Analysis” tab and select “Curve Fitting”. In the “Function and data” tab, select a linear fitting. It is recommended to perform the fitting of the curve between -0.9 and -2.1 V, so this interval will be delimited using the A and B cursors (displayed with Ctrl+I). In this “Function and data” tab, also select your duplicated extension as Y wave and your duplicated force as X wave. In the “Data Options tab”, select Cursors as Range.

6. After fitting the curve, the Command Window will show a linear equation in which the first part of the b parameter represents the Contact Slope. Using this value, calculate the Spring Constant using the Equipartition Theorem and your Vrms2 value (on the Calibration info box at the Calibration panel).

7. Use the calculated values of Spring Constant and Contact Slope in your experiment.

**EXPERIMENTAL PROCEDURES**

Once the cantilever is calibrated, experiments can be started. It is always a good idea to start doing force extension because these kind of traces provide information about the calibration of the cantilever and allow us to check if it has been done properly (we recover the expected changes in contour lengths, unfolding forces and get a vertical contact slope).

**Force extension experiments**

The Force Extension (FX) analysis is used to determine the change in contour length of each Ig domain, due to the unfolding process, and the force required to unfold the domains. This can be done thanks to the Ksc parameter, which permits IGOR Pro to measure the resistance force and changes in length. (e.g: for the (I27)8 protein, the step has a length of 28-29 nm and the average force is ~200 pN).
When performing a FX experiment the first step is to set the value of some parameters (Figure 6):

1) **FX Settings Box:** pulling rate (400 nm/s), amplitude (500 nm).

- **Pulling rate:** sets the piezo movement speed in nanometres/sec.
- **Amplitude:** sets the maximum displacement of the piezo during the FX measurements (from the start position, in nanometres). The programmed excursion of the piezo is represented in the graph. Excursion should be always within the range of the piezo (grey horizontal lines). Set the amplitude so that you can observe detachment in your traces. The right value depends on the unfolded length of the polyprotein.

2) **AutoSave Box:** Activate Sawtooth detector, set Stringency = 0.2 (arbitrary units, AU), and Min Force = 75 pN.

- **Sawtooth Detector:** enables selective saving during AutoFX for the traces that show a distinct sawtooth fingerprint only. Checking the Sawtooth Detector Box activates this feature.
- **Stringency:** is one of the two parameters used for selecting traces. It sets the threshold for the definition of the Sawtooth fingerprint pattern.
- **Min Force:** is the second trace selecting parameter. Sets a minimal pulling force threshold over which the Sawtooth Detector works.

3) **Filter:** Nyquist Fraction = 0.5 (no filtering)

- **Nyquist fraction:** parameter related to the cut-off frequency of every Force Extension trace after completing acquisition. A higher value leads to less filtering.
After setting these parameters, the analysis can be carried out as a single or an automated experiment.

The single FX button executes a single FX measurement according to the parameters specified in the FX settings box (1). The acquired data trace is displayed in a separate window. After acquisition has been completed, the data are passed through a software filter according to the settings in the filter box (3).

Single FX measurements are taken to properly calibrate the cantilever (see above) and to check whether the cantilever is placed in an appropriate distance from the surface or not. If everything is working fine (i.e: at the end of the acquisition, a linear trace composed by a forward and a backward components should be seen with no hysteresis) an Auto FX experiment is started.

The Auto FX button starts repeated and fully automated acquisition of FX traces. Automated operations can be stopped by holding down the Ctrl button on the keyboard.

Note: Set the contact force by typing in the command line the desired work value. For instance: FXcontactforce = 2000. This parameter should be adjusted for each experiment so that a good number of decent traces is obtained. A higher value means more pickups, but the probability of getting traces showing non-specific interactions also increases.

IMPORTANT: In case of emergency, the Abort button at the bottom of the IGOR window can be used, but this may lead to malfunction of the software. If the motors moving the piezo and the detector fail, they can be reinitialized using the “Reset Agilis” command.

6) Top display: This parameter is qualitative and has the possible values “too far, okay, close, too close”.

Adjustments made by the PID to move the piezoelectric are only made if the sample surface is too far or too close to the cantilever tip.

Force clamp experiments

After determining the change in contour length of each Ig domain and the force required to unfold the domains by FX, Force Clamp (FC) experiments may be started. This procedure establishes a constant pulling force (or a controlled change in force) in contrast to FX. Thanks to it, it is possible to calculate the main unfolding force for each domain (force ramp), unfolding rates (force-clamp) or refolding fraction.

In these experiments, each time an unfolding event takes place, the unravelling of the trapped amino acids leads to a sudden increase in protein extension. When using polyproteins, the length vs. time plot shows a staircase-like change in length, with each step corresponding to the unfolding of a domain in the polyprotein.
Just like FX experiments, the first step is to set the value of some crucial parameters (Figure 7):

![Force clamp tab](image)

**Figure 7:** Force clamp tab, which contains all the controls necessary to run single or automated FC experiments

1) **Contact Conditions Box:** Contact Force = 1500 pN, Contact time = 1 s

- **Contact Force:** sets the pushing force (pN) of the contact phase before the data acquisition starts.
- **Contact Time:** sets the duration (sec) of the contact phase before the data acquisition starts.

Suggested values are good starting points, but at the beginning of the experiment check whether you are getting a reasonable number of good traces and adjust them accordingly. Higher forces or longer times increase the probability of picking up molecules (but also multiple tethers that we want to avoid!)

2) **Auto Save:** Min # steps = 0, Min hold time = 3 s

- **Min # steps:** one of the parameters that sets the stringency of the requirements for saving a trace during AutoFC experiments. It sets the threshold for the number of well-defined steps in length that are required for saving a trace.
- **Min hold time:** the second parameter for setting the stringency of the requirements for saving a trace during AutoFC experiments. It sets the minimum time (sec) that a trace must last before detachment in order to be saved. The right value gives you a compromise between useful data (for instance, if you know that you need traces that are longer than a cut-off time, there is no point in saving shorter traces) and amount of traces.

3) **Filter:** Nyquist fraction = 0.5

- **Nyquist fraction:** parameter related to the cut-off frequency of every force extension trace after completing acquisition. A higher value leads to less filtering.
4) PID feedback Box

Recommended values
Gain =3.3, Integral = 0.5, Derivative = 0, Proportional = 0. (MLCT cantilevers)

Gain (0-10): controls the overall gain of the system (gain values below “1” are not recommended, as this will decrease the piezo range)

PID can be used to adjust the settings of the FC PID feedback system. Each component can be set individually using its input box or corresponding slider. The PID allows the adjustment of the force detected by the system to the one manually set using the integral, derivative and proportional components.

The response time of the feedback can be improved by increasing the feedback parameters. Integral parameter can be the only one used because it is normally enough to reach an adequate feedback. Setting these parameters too high, will result in oscillations that can potentially damage the piezo, so it is recommended to start with low values.

Optimal feedback parameters have to be manually determined for each cantilever and experimental set up. Response times, measured from the time it takes for the force to recover after an unfolding event, should be < 5 ms.

5) FC protocol table: allows the user to specify a force clamp/ramp experimental protocol.

There are three columns: “Force”, “Time” and “RampOn?” Each row represents a force pulse and, for each pulse, the “force column” represents the desired set point force in pN, the “time column” specifies the duration of the pulse in seconds. The “ramp on? Column” can contain either a “0” or a “1” representing the absence or presence of a ramp, respectively. The ramp starts at the set point force of that pulse and ends at the set point force of the following pulse. The full protocol is displayed in the FC protocol graph (Figure 7), a graph which represents the set point force (pN) in the vertical axis vs. pulse duration (sec).

Note: a negative value represents a pulling force whereas a positive value represents a pushing force.

Note: the last pulse of a FC protocol cannot be a ramp.

Note: all columns in the FC protocol table must have an equal number of rows.

Note: it is not possible to set a value lower than 3 sec in “Time column”, because the sampling rate will be too high.

After setting these parameters, FC can be carried out as a single or an automated experiment.

The single FC button executes a single FC measurement according to the contact settings specified in the Contact Conditions Box (1), the feedback settings specified in the PID feedback Box (4) and the protocol specified in the FC protocol table (5). The acquired data trace is displayed in a separated window. It is generally a good idea to run a single FC to check the feedback parameters do not drive the piezo to oscillation. If it starts oscillating, readjust the feedback parameters.
The Auto FC button starts the repeated and fully automated acquisition of force clamp traces. Just like Auto FX, these experiments can be stopped holding down the Control key.

IMPORTANT: In case of emergency the Abort button at the right bottom of the IGOR window can be used, but this may lead to malfunction of the software.

This field shows how many FC traces have been acquired and saved, respectively, since the experiment was started.

FINISHING THE EXPERIMENTS

1. Stop the experiment (hold Control key) and save it.
2. Open the laser safety hood.
3. Close the dartboard to cover the detector. This prevents any spilling from reaching the detector. Use a tissue to protect the objective from potential spilling.
4. Use the double arrow key to Retract the piezoelectric from the sample surface
5. Rotate the piezo to its rest position.
6. Remove the fluid cell from the system.
7. Remove the O-ring and the cantilever from the fluid cell, wash them with distilled water and allow them to air dry.
8. Wash the fluid cell using tap water, 70% ethanol and distilled water. Then dry it with compressed air.

Note: Never use a cloth to clean the chamber because it may loose some fibres or salts that can scratch the cell surface.

9. Turn off the high voltage option and laser intensity.
10. Close IGOR.

DATA ANALYSIS

Trace selection

1. Only traces showing a repetitive fingerprint are selected (that is so, at least two sawtooth or staircase-like motifs are required in the case of a homopolyprotein).
2. The selected traces must be “clean”. In general, it is possible to select a trace which has noise at the beginning of the acquisition, because the cantilever can be attached to a few proteins or aggregates when first touching the surface that will be released later on. Furthermore, traces with noise at the end can also be selected because these fluctuation can be due to protein detachment. However, it is not recommended to select a trace that presents fluctuations in the middle of the unfolding steps because this kind of noise cannot be explained by molecular means.
3. In FX experiments, detachment is required in order to select a trace (to ensure return to baseline force levels).
4. In order to select a trace in FC experiments, the initial and probe proteins must have the same final length and the same final unfolding force within a range of 15 nm (refolding analysis) or
4 nm (for analysis of the mechanical stability of the refolded domains). These values have been determined empirically.

5. At the end of the trace, the exerted force must have reached the cut-off force (force-ramp), the cut-off time (force-clamp), giving all the domains the chance to be unfolded.

Note: always take into account that these general criteria may vary depending on specific needs; for instance, if the initial extension before unfolding needs to be determined, only clean traces from the beginning should be used.

Selected traces analysis

Force extension

The following lines explain how to fit the worm like chain model of polymer elasticity to a polyprotein sawtooth pattern.

1. Double click on one of the scale numbers of the Y axis, a window showing different parameters is displayed and, in the option “Manual min”, change the minimal value of the Y axis to -200 pN.

Note: the “Manual min” may change according to the protein used in the experiment.

2. Select the A cursor and place it on top of the last peak of the trace.
3. Click “# curves” button in the AFM analysis window until the same number of curves as peaks in the representation has appeared.
4. Change the variable “delta” (delta contour length) and “p” (persistence length) to alter the separation and shape of the curves displayed with “# curves” button until they completely fit the peaks, according to the worm like chain model of polymer elasticity.

Force clamp

There are different approaches to select the interesting traces of the FC experiment, and to calculate the unfolding/refolding rate of the polyprotein’s domain:

A) Determination of the unfolding rate by cropping selected traces (experiments at constant force).

1. Open the desired experiment with IGOR. You may get warning and error messages. Ignore them. If you need to cancel a command (e.g. move a window that does not exist), write “//” before the command to inactivate it.
2. At IGOR toolbar, select File → Open file → Procedure… → Desired Analysis File
3. Select the option “Compile”, which is located at the bottom of the pop-up window.
4. At IGOR toolbar, select Macros → Analysis. This way, the “AFM Analysis tab” will appear.
5. At “AFM Analysis tab”, select your desired value as “Custom tick”. This option allows the visualization of the Y axis as divided in “custom tick” nm-long sections, which makes it easier to determine whether a step is “Custom tick” nm-long or not.
6. At “AFM Analysis tab”, there is a box that contains the trace number, and with the arrows located next to it, it is possible to change from one trace to another and study the different
pick-ups. So, it is possible to determine which ones are interesting for our study according to the features considered in Trace Selection section.

Note: It is recommended to write down in a notebook the selected traces, as well as the time they lasted (take a look at the X axis, where the time variable is represented and write down how much time takes the protein to detach).

7. Within each trace, select the region of interest, which is the one containing the fingerprint.
   ✓ Grab the A cursor and drag it until the beginning of the region of interest.
   ✓ Grab the B cursor and drag it until the end of the region of interest.
8. At “AFM Analysis tab”, change the traces destination from “root:FC_Analysis:SumTraces” to “root:FC_Analysis:SumTraces:forcevaluepN” (forcevalue equals to the working force of the experiment, e.g. 180pN).
9. Once the region of interest has been chosen, click “Cut Trace” at the “AFM Analysis tab”.
10. Repeat steps from 7 to 9 for all the selected traces.
11. Represent the cut traces.
    ✓ Change the current directory from Data to FC_Analysis: forcevaluepN, to do so: move the red arrow from Data (at IGOR toolbar) \rightarrow Data browser \rightarrow FC_Analysis \rightarrow SumTraces \rightarrow to forcevaluepN.
    ✓ Select the first cut trace (which now it is called cut_FC_LengthXX) and right click it to select the “Display” option.
    ✓ Right click at the graph and select the option “Append traces to graph”.
    ✓ Select the remaining traces.
12. Determine the minimum time at which almost every polyprotein has finished unfolding (when no more steps are seen).

Note: Defining a minimum duration for each recording avoids biasing the measured rates. Weak polyprotein anchoring leads to a high probability of detachment, which can take place before all the events have occurred. Without a strong selection criteria for minimum duration, slow events will be missed and the rated will be overestimated (Popa et al. 2013)

13. Remove from the graph all the traces shorter than the minimum time. It may be easier to identify short traces by looking into the duration times recorded in the notebook.
14. At IGOR toolbar, Data \rightarrow Data browser \rightarrow FC_Analysis \rightarrow SumTraces \rightarrow forcevaluepN highlight the traces removed from the graph in order to exclude them in the following operations (e.g. change the beginning of their name).
15. At “AFM Analysis tab”, click the “FillUp?” button to adjust all the traces to the same length (this option adds points of the same value as the last one in the trace until its length is the same as the longest one).
16. At the “AFM Analysis tab”, click Sum’em up. A new graph named “Summed” will appear, representing a single curve.
17. At the IGOR toolbar: Analysis \rightarrow Curve Fitting, in order to generate a new curve which fits to our representation.
    ✓ At Curve Fitting \rightarrow “Function and Data” tab. Create a new adjustment function (e.g. a function named \textit{expori} (F(t) = \textit{Fo} \times (1-exp(-k*t))). Its coefficients are \textit{Fo} and \textit{k}, and the independent variable is \textit{t}). At “Y data”, select “From target”.
At Curve Fitting → “Coefficients” tab. At the “Initial Guess” box, select, for Fo, the maximum value that the “Summed graph” seems to reach in its Y axis; and, for k, use an estimated value.

At Curve Fitting → “Output Options” tab. Select “X Range Full Width of Graph”.

An exponential curve will appear fitting the “Summed” graph.

Press Ctrl+J and the commands window will appear showing the Fo and k values. Copy them and paste them at an annotation box in the graph. To create this annotation box, right click at the graph and select “Add annotation”, which is the place where you should paste your data. It may be a good idea to change the name of the waves “summed” and “fit_summed” to, e.g., “summed_180pN” and “fit_summed_180pN” for easier identification.

B) Determination of the unfolding forces distribution in a force ramp in unfolding/refolding experiments.

1. Follow steps 1-6 as above

Note: It is recommended to write down in a notebook the selected traces, as well as the fact whether they contain refolding events or not (take a look at the force ramp at the end of the experiment, where it should be seen a staircase-like pattern if refolding takes place).

2. A trace can be used to study refolding events if the final force experienced by the protein and its final length are the same at the end of the unfolding and refolding event. If there is a difference in the final length between both events, it cannot exceed 15 nm (for refolding analysis) or 4 nm (to measure mechanical stability of refolded domains).
   - To check the difference in length between the unfolding and refolding place the A cursor at the final length of the unfolding protein and the B cursor at the end of the refolding process. “dY” shows the difference.

3. Change the work directory from Data to FC_Analysis. Data → Data browser and move the red arrow to FC_Analysis.

4. Create a table to write down the unfolding forces, the number of the trace and the length of every step from each trace, which are the waves FCforces, FCstepsNo and FCsteps, respectively.
   - At IGOR toolbar, Windows → New Table and select wave FCforces in “Columns to edit” option.
   - At IGOR toolbar, Data → Data browser → FC_Analysis. Select the waves FCsteps and FCstepsNo by right clicking them and select the option “Append to table”.

5. Once the table has been created, open the selected traces using the “AFM Analysis tab”.

6. Click at the beginning and end of every step and press “m” on the keyboard. Repeat for every step.

Note: it is important not to have the “Bloq Mayus” option activated the moment “m” is pressed.

7. Repeat step 6 for every selected trace.

8. Using the command window change the FCforce column values from negative to positive.
IMPORTANT: When performing step 8 the red arrow must be placed at FC_Analysis so that the command applies to the wave.

9. At IGOR toolbar → Analysis → Histogram.
   ✓ Select “from target”
   ✓ Manually set bins (e.g. Number of bins: 10 and Bin Width: 25).
   ✓ Display Output Wave → New Graph
   ✓ Source Wave → FCforces

10. Double click in the recently created histogram and select “bars” at “bars mode”.
11. At IGOR toolbar → Quick Fit → Gauss, to adjust the histogram to a Gaussian.
12. To fit the Gaussian to the centre of each histogram bar double click the Gaussian curve. Select “Offset” and write down the number corresponding to half the bin width (e.g. if the bin width is 25 nm use 12.5 nm).

C) Determination of the refolding forces distribution in unfolding/refolding experiments.

In traces in which refolding events can be seen, analysis of these events should be done as indicated in section B but with the following considerations:

1. A new table must be created. As the waves FCforces, FCsteps and FCstepsNo have been already used to obtain the distribution of the unfolding forces, it is necessary to empty them without losing the values they contain. To do so:
   ✓ Create a new table. Windows → New Table. Click Do it without selecting any wave.
   ✓ In the upper bar of the table, write “0” and press the Intro key. A new wave will be created this way with the name “wave0”.
   ✓ Click the following column and then write “0” in the upper bar once again to create a new wave named “wave1”. Repeat this process to create “wave2”.
   ✓ Rename the waves as “FCforces_unfolding”, “FCstepsNo_unfolding” and “FCsteps_unfolding”. To do so, click, at the IGOR toolbar, Data → Data browser → Data (where the new waves have been created). Change the waves’ names by clicking on them.
   ✓ Copy the data recorded in the first table and paste them in the new one. This way the first table is now empty to record new data from refolding events.

The remaining steps must be followed in the same way as described in paragraph B).

TROUBLESHOOTING

- The laser on the target is not circular. Try adjusting C-D manually, moving and/or tilting the focusing mirror, filling the fluid cell with buffer so that the cantilever is totally submerged in buffer. If nothing works, maybe there is an issue with the position of the cantilever chip in the fluid cell. Remove it. Clean the fluid cell. When dry, try to assemble the cantilever again and pay attention to how it fits into the receptacle. Is it crooked?
- While calibrating the approach to the surface is not straight but there is a continuous change in A-B before getting the real slope. This may be an indication that the coverslip is not well glued to the piezo. Reassemble it.
- While calibrating the approach to the surface is very rounded. There is too much protein. Try to rinse the coverslip with buffer to see if it improves. If it does not improve, set up a new coverslip with less protein.
- Few pickups: try adding more protein in the next experiment.

REFERENCES

